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Getting Started

The PEPFAR M&E v1.3is a "runtime" application; you do not need
additional software in order to use it.

MINIMUM SYSTEM REQUIREMENTS
To install and use the NERC PE system, you need the following
minimum configuration:

Pentium Il (Windows) or G3 (Mac OS) processor or faster computer
with at least 128 MB RAM (Mac OS) or 32 MB RAM (Windows gg,
Windows 98, Windows NT 3.51 or later, Windows Me, 2000 or XP)
with at least 20 MB of disk space available. Monitor with 8oox600
resolution (1024x768 or higher strongly recommended).

Installing the Software

You'll need at least 20 megabytes of free space on your hard drive
before you can install the software.

If you downloaded the software as a “zipped” file, you will need to
extract the files before installation. After extracting the files, locate
and double click the “pepfarSetup.exe” file. If you have the software
on CD, insert the CD in your computer CD drive and it should start
automatically; a Setup wizard will prompt you through the
installation process.

The PEPFAR M&E system allows you display and print barcodes
instead of client names. In order to display and print barcodes, you
will need to install the barcode font included in the “Fonts” folder. To
install new fonts to your computer

Click Start, point to Settings, click Control Panel, and then double-
click Fonts. If you don't see the item you want, click view all Control
Panel options, and then double-click the item.
1. On the File meny, click Install New Font.
2. Locate the drive that contains the PEPFAR M&E CD-ROM, and
then open the folder titled ‘Fonts”.
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3. Click the font you want to add.

Note: You may download the barcode font from our web site:
http://www.aidatasolutions.com/fonts/BARcode.ttf

Documentation

In the PEPFAR M&E CD-ROM you will find a folder named,
“Documentation” This folder contains a user guide (this document)
in PDF format. You will need to install, or have Acrobat Reader on
your computer in order to access PDF documents. The electronic
version of this document is accessible by choosing “help” from the
“Help” menu item.

Installing Acrobat Reader

A copy of Adobe Acrobat Reader is included in the “Extras folder” To
install, double-click the icon and follow the on-screen prompts
Note: The “Extras” folder is available on CD-ROM version only

STARTING THE SYSTEM
After installing the system, an icon will be placed on your desktop,
double-click the icon to start the application.

ENTER YOUR PASSWORD

Once the system starts up, you will be prompted to enter the
password assigned to you. If no password has been assigned to you,
your initial password to access the system is "User".

CHANGING YOUR PASSWORD
You can change your initial password at anytime. To change your
password
1. Choose Edit menu > Change Password.
2. Inthe Change Password dialog box, type the current password
in the Old password text box.
3. Type the new password for New Password, and again for
Confirm new password.
4. Click OK.
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Change Password @@

IJse these Fields to change the password for wour account, Please enter your old
password once and vour new password bwice,

Account Name: Admin

2id Passward: | |

Mew Password: I

Confirm Mew Passward: |

(] 4 I Cancel |

The Change Password Dialog Box
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Navigating the System

THE MAIN MENU

The system always opens with the main menu. You can access all the
menu commands and commonly used features from the main menu.
While navigating the system, you may return to the main menu at
anytime either by clicking on the “Main menu” button displayed on
the “"Main Screen” of each module or choosing from the "PEPFAR”
menu item.

MAIN MENU

The “*Main Menu” button

ISerwiue Outlets/Programs ICJients Served IHe-alth Workers Trained IProcummenlfCommoditieu
Reports Impact Level Indicators
MAIN MENU Service Sites PMTCT [=] I]
President’s Emergency Plan for AIDS Relief PEPFAR DISPLAY DATA NIGERIA

SERWICE OUTLETS/PROGRAMS
b select filter:

Faith-Based =8
CLIEWMTS SERMED

pselect filter:

[ger 5+ (Female) [>]
HEALTH WORKERS TRAIMED
bselect filkar:

[Treatmeant (ART) =8

GECGRAPHICAL COVERAGE OF SERVICE SITES

® abuja, FCT O Bormo O Irmo O Lagos O Rivers

O Abia O Cross River Oobe O Masarawa O Sokoto North E=st
O Adamawa QDelta O kaduna O HMiger O Taraba

O akwa Iborn O Eda O Kana QO <gun O digawa

QO Anambra O Ekiti D katsina O Ondo ) Zamfara

O Bauchi O Enugu O kebhbi O oya

O eayelza O Ebonyi O kogi O osun South East
OBenus O Gembe O Kwara O Plateau

The System Main menu
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Recording Notes

Clicking the Record Notes icon - on the clients screen will launch the
Microsoft® sound recorder, you will need to have a microphone
plugged into the microphone jack of your computer and properly
configured in order to record notes.

‘“, Sound Object in clients Q d

File Edit EFffects Help

%TO pIayback Position: - Length:
recorded notes, right- ‘ 0.00 sec. ‘ 0.00 sec.
|
I

click the audio icon and
choose "Play Sound

Recorder Document” Bl | “l b | . | d |

Displaying Service Sites by Geographical Coverage

From the Main Menu, you can view service sites in each state by
clicking on the radio button next to the name of the state and then
clicking the “Submit” button.
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THE MENU BAR
The menu bar has five menu options, File, Edit, PEPFAR, Reports
and Help.

The PEPFAR Menu

File Edit Reports  Help

Main Menu 1ts

Enter or Modify Data » o
MAIN MENU

Main Menu

The main menu is displayed each time the system is launched. From
the main menu, you can access all the commands and features that
make up the system

Enter or Modify Data Submenu

This option features a submenu that provides access to the Service
Sites, Clients Served, Health Workers Trained, and
Procurement/Commodities “Main Screens”.

File Edit Reports  Help

1ts Served Iiealﬂ

Service Outlets)Programs
Clients Served

Health Workers Trained
ProcurementCommodities

Main Screen

Each Main Screen displays all the information associated with a
particular record in a particular module. You can enter or modify
information from the main screens only.
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File Edit PEPFAR Reports Help

—IServicEOutlein.megmmu ICliamaSened IHeathurhers'i"raimd IPmmmnent."ComnodJﬁen
Select Impact Level Indicatar
MAIN MENU [+]
Aminu Kano Teaching Hospital Find ) [ ] ) 59l

Servies Site Service Site Type Print blank SIS data capture form
|Aminu Kano Teaching Hospital Hospital vI -

Services/Programs

I'I'reatment [ART) |l|
|Medica| Transrmiszion: Blood Safety |l|
|HI‘ur Counseling and Testing |1|

DECIMAL DEGREES or DEGS, MIMS, SECS

LATITUDE LATITUDE

Address

|123 Main Highway | )
. (+ OR -] if Lat=15, (+ OR -} if Lat=5,
PO Box/PMBE Geographical Coverage enter a5 positive enter az positive

| llll lll LONGITUDE LOMGITUDE

[+ <R -] if Lan=l, [+ OF -1 if Lon=,
enter as negative enter as negative

Zortack First Marne Contack Last Marne Tite

Teli Fad Mobile1
| 2 | = e Start Date End Date

Tel:2 Faw:2 Mobile: 2 | |
| | Total Arount USD Tokal Amount MG

Ernaill (PHrmary) Ernail:2 Ernail:3
| | ServicesPrograrns  Arnourt Allocated
Treatrnent (ART)

MMedical
Transrmission:
Received TA? TA StartDate TAEnd Date A Program Area HIY Counseling
[wves Mo | Policy Develapment ILI and Testing

Service Outlets Main screen

The File Menu

Print Setup

Use this feature to select a default printer, and change paper size
and orientation. Important: Printer and print setup options depend
on the printer and system software you're using. Refer to your
printer and system documentation for more information.

Print
The Print command opens the Print dialog box, which allows you to
choose an option before printing.
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To print

Choose

All records in the found set

Records being browsed

Only the record currently selected
in Browse mode

Current record

A blank record using the current
layout (use this option to print a
blank "form")

Blank record, showing fields,
then choose a formatting
option

A list of all the fields defined for the
file, including formulas and entry
options

Field definitions

A list of all script steps for one script
or all scripts in the file

Script definition for, then
choose a specific script or all
scripts

Select the print range, number of copies and other printing settings,

and then click OK.

Other print options depend on the printer and system software
you're using. Refer to your printer and system documentation.
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Import Records

You can import data for “Service Sites, Clients Served, Health
Workers Trained, or Procurement/Commodities” into the system
from other applications. The records you import become “the found
set”. When you import, you can add new records, replace or update
existing data.

If you're replacing or updating data; first make a backup copy of your
records; replacing and updating will overwrite data and is
irreversible.

1. Choose File menu> Import Records [Service Sites, Clients
Served, Health Workers Trained, or
Procurement/Commodities].

2. Inthe Open File dialog box, for Files of type (Windows) or
Show (Mac 0OS.), choose a file type to narrow the choices, or
choose All Files to see all the files in the current folder that you
can import.

3. Select the name of the file to import, and then click Open.

4. If you're importing a Microsoft Excel file that contains more
than one worksheet or includes a named range, you see the
Specify Excel Data dialog box. Select the worksheet or named
range that you want to import and click OK.

5. If you're importing a Microsoft Excel file, you see the First Row
Option dialog box. Choose whether the first row of data in the
worksheet or named range is field names or data.

6. Inthe Import Field Mapping dialog box, you can view the data
in the file you're importing from by clicking the Scan Data
arrows to see the data in each record before you click “Import”

7. Inthe Import Field Mapping dialog box, choose the type of
import you want to perform.
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Choose To page
Add new records Add new records to the end of the database 12 of 28
Replace data in Replace data in the database with data from

current found set the source file, in order, starting with the

first record in each file




Choose To

Update matching Update data in the found set with data in

records in current matching records in the file you are

found set importing from

Add remaining Add records from the found set of the

records source file that do not have matching
records in the database

8. Inthe Import Fields Mapping dialog box, line up each field in
the “Target Fields” list with the data or field you want to
import from (or match for import update). Data on the left
that is not aligned with a field on the right will not import. If a
field name on the right is dimmed, it cannot accept imported
data.

Import Field Mapping
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Source: clients_served.csw Target: clients
Source Fields | | Target Fields |i.
110 = # PatientID o
Amava =F # PakientLastMame
Elizabeth =k * PatientFirstMarne
January 25, 1975 = # DateOfBirth
25 = % Age
15+ =+ # AgeRange
Female =¢ # Sex
— %
— %
% v
::::l }}-l Record Z of 4 Arrange by | custom import order LI
Character set:l Wwindows [AMNSI) LI
Import Ackion Field Mapping
i add new records = Import this field
™ Update existing records in Found set o B ligert i Tl
. = Match records based on this Field
Update matching records in Found set Y e e e
I™ add remaining data as new records Define Database. ., | ade
[ Don't impatt First record fcontains Fisld names) p g 8
Impork I Cancel | 13 OoTf 20

The Import Fields Mapping Dialog box




Import ODBC (Open Database Connectivity)

In order to use the import ODBC option, you will need to first
configure MySQL connector ODBC 3.51 driver (MyODBC), which is
available for download from our web site
(http://www.aidatasolutions.com/mysqlODBC.zip) (please see
Appendix C for steps to configure MyODBC()

Once you have properly configured MyODBC, you can access and
import data from the MySQL databases stored on our servers.
(Please Note that data available for import must have been
previously input through a web interface) The MySQL database you
are importing from will have identical field names with those in the
destination module so you do not need to line up each field in the
“Source Fields” list with the Target fields.

In the Import Fields Mapping dialog box, check the "Don’t import
first record (contains field names) box, and from the “Arrange By”
drop-down box, select *matching names” Choose other data import
options as appropriate
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Select ODBC Data Source

Select one of the data sources that has been set up on wour machine.

(ou can set up additional data sources by Following the procedures described in
the documentation for each ODBC driver, )

Daka Source MName Driver
dBASE Files Microsaft dBase Driver (*,.dbF)
Excel Files Microsaft Excel Driver (*.xls)
M3 Access Database Microsoft Access Driver (*.mdb)

pepfar MySOL ODEC 3,51 Driver
TrioMatars Micrasaft Access Driver (F.mdb)

—
14 of 28

Continue. ., I Cancel

The Import ODBC Dialog box




Export Records

This option allows you to export data to another program
1. Inthe dialog box that appears, type a name and select a
location for the file. Important: If another file with the same
name already exists in the same location, this new file replaces

the existing file.

2. Choose afile type from the Save as type list

3. Use a file format supported by the application in which you

plan to use the exported data. (If you plan to export to Excel or
Word, use the Tab-separated Text Files (*.tab), or the
Comma-separated Text Files (*.csv) formats)

4. Inthe Specify Field Order for Export dialog box, indicate the
fields that contain the data you want to export from the
selection on the left, and click the "Move" button

5. When you are done, click the "Export" button

Specify Field Order for Export

before moving the other fields,

Select and move the fields to be exported. IF wou wank to group data, choose the 'Group by Fields

[ apply current lavout's data formatting to exported data

Export I

Cancel

I Current T able ["clientz"] LI Group by

Address1 s {Unsorted)

Addressz =1

age

AgeR.ange E

Allergies

ART Field export order

Barcodedata ¢ PatientD W

[Miowe —

Barcodeout I ) =

EloodType # PatientLastMame =

BloodType_Hb_Hct Mowe All | # PatientFirsthame

BloodType_IDC # DakeCfBirth

BlﬁllzuddType_Rh Clear All $ Age

Children

+

CarmmentsMaotes facRonge

CZonskankt * Sex

CountiClients w ¢ Addressl hd
—iopkions

Cukput file character set; I Windows [AMSI) LI

|

The Specify Field Order for Export Dialog box

=
[}
=
v
>
V)
4~
=
()
=
L)
o
(0}
=
M
=
M
i
[}
(@)
——
=
o
o+
m
=
()
=
L
od
(=]
(=
; Ty
@]
=
=
o
=
<
L
o
Ll
o

| page

15 of 28




Exit
Closes all open files and exits the system.

The Reports Menu

The layout and structure of the reports in the system derive from the
“President's Emergency Plan for AIDS Relief Indicators, Reporting
Requirements and Guidelines”

Program-Level Report

The Program-level report is based on the framework developed for
monitoring program level results achieved by the Emergency Plan,
and includes number of service Sites, number of clients served
disaggregated by sex, number of organizations provided with TA
and number of individuals trained.

Clients Served
The Clients Served report lists all clients served disaggregated by
age and sex and summarized by state

People Trained
The People Trained report lists all people trained including Training
Program Area disaggregated by state

Service Sites

The Service Sites report lists all service sites including
services/programs provided, total number of clients served
disaggregated by state

The Help Menu

From the Help menu, you can access the electronic version of this
document by choosing the “Help” command. For information on
contacting the developer, choose the "About” command.

THE BUTTONS PANEL

Using the Buttons panel, you can move forward or backward one
record at a time, or jump to the first or last record, create a new
record, delete a record or records, or show all available records
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IRl b

Navigating Records
These navigational arrows allow you to move forward or backward
one record at a time, or jump to the first or last record

| i ) e

Show All Records

Clicking this button will display a list of all the records in a particular
module

DIRI ek [

New Record
Clicking this button will add a new

blank record to a module «“| 4] ] ﬂ i

Delete Record or Records

Clicking this button displays a dialog that prompts you to either
delete the current record being browsed or all the records in a
module. Please note that either action will permanently delete
record(s), and CANNOT be reversed.

| ) O O]

Find
Clicking the “Find” button puts the system in “Find Mode”
and allows you to perform a search using various search criteria.
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VIEWING DATA

The system provides two ways to view data, a "Form view", and a
"Table view". Form view displays a record at a time; while Table view
enables you view multiple records at once.

Form View
You can view and edit all the information associated with a particular
module in Form view or “"Main Screens” only. Use the navigational
arrows to move forward or backward one record at a time, or jump
to the first or last record in each module.

L ANAN.

Table View

If you were to click on the "Show All” button from the Service Sites
module, a list of all service Sites in all the states is displayed in “Table
view"”. In table view, multiple records are displayed on your screen at
once.
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FINDING INFORMATION Q
You can have the system find Service Site(s), Client(s) BTk d
Served, Health Worker(s) Trained, etc, by clicking the “find”

button from any “"Main Screen”. You can search for a particular

record or a group of records. To find records, you specify search

criteria e.qg. program area, "Treatment (ART)". A search examines all

the records in the system and depending on the module, returns
relevant search results, (the "found set") the set of records that

matches the search criteria. The search results are displayed in Table
View. If a search returned only a record, it displays it in Form view.

For example, if you searched for service Sites in "Abia" state and the page
system locates more than one site (the found set) the list is displayed 18 of 28
in Table view. Clicking on the name of any service site in the found
set will take you to the Form view or "Main screen" that displays
detailed information on that service site.




Using the System

ENTERING DATA

You should only enter, or modify existing data in Form view or from
the appropriate "Main Screen". To modify existing data, click in the
field or fields that contain the data you wish to modify and simply
type over it. To enter new data, choose the "New” command from
the Buttons Panel and fill-in the appropriate fields.

File Edit PEPFAR Reports Help

Select Applicable Program
MAIN MENU PMTCT El
Hafsat Baraya Find ] [ 2 ] S B E
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Service Site/Location (Select from List) @I Print Client Recards with Mame & Barcode
|.F|minu Kano Teaching Hospital lll

1ID# Patient Last Narne Patient First Marne
|1IZIEI |Baraya |Hafsat

Address

PO Eo el Mobile Phone Refill Dates Achive Prescriptions Allergies

| |Kano Illl 0&/01/2006 |Lopinavir/ritonavir | [Mo known allergies
£ Pregnant? Pregniancy Status 0&/25/2006 |Arnpranauir
[Imale [EFermale [FEves [IMo weeks: [13 07/03/1006 |Mevirapine

ReceivingTreatrnent (B8] Age
OarT EpMTCT | | Precord otes Gy

Age Range patient is
recaiving

[Jo-14 15+
TR combination of

Erint Client Records with Barcode anly

Nnmmanm Sz Tjete Lapinavir +

ritomavir (LPWS )

nimmmmim
San R |IDC |Hb.fHd:

PMTCT Counseling ARM Therapy TB Therapy
|08f03f2005 |06.-"Dl.-’2l:ll:l6 |06.-"01.-’2DD6

Ernergency Contact Relationship Mobile Phone Murse Last Nurse Murse D
[Haladu Baraya  |[Husband | [Helen Aliyu [pas03/2006 [pas21/2006
Parents Siblings Children Physician Last Physician Physician Due
Meharned & [+ 2 [or H. M MUktar [p7/01/2006 [p7/20/2006
Married Religian Education Lah Result Last Lahs Lah Diue
[dves [IHe |Mus|im |High school |CD4+ count 350 |DE-.|"D?.|"2DDE- |D?.|"D?.l"2006

Clients Served Main screen

ENTERING AND UPDATING INFORMATION
To update information on an existing service site, client, or training
participant, first use the find button to locate the site, client or




participant and the system should automatically take you to the
appropriate "Main Screen” If not, choose the "Main Screen” of the
module you wish to update information for. Supply new information
for the site, client or training participant by typing over existing
information. Move through the data fields by clicking in the desired
field, or using the tab key on your keyboard.
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Appendices

APPENDIX A - GLOSSARY

Word Meaning

Application Software that performs a specific task or function, such as word-processing,
creation of spreadsheets, generation of graphics, facilitating electronic mail,
etc.

Ascending A sorting order that starts with the smallest (or oldest) value and ends with the

Sort largest (or most recent) value and proceeds in numerical order. For text, values
are arranged alphabetically (A-Z). Dates and times are sorted in chronological
order.

Browsed Those records in the database that are currently visible.

Records

Browse Mode

In this mode, you can add, view, change, sort, omit (hide), and delete records.
Browse mode is where you'll do most of your work, like data entry

Current Field

The database field that is currently selected (by tabbing or clicking in the field).
Only the current field can be modified.

Current The record that is currently selected. Only the current record can be modified

Record

Database An organized collection of information, normally with one central topic.

Descending A sorting order that starts with the largest (or most recent) value and ends with

Sort the smallest (or oldest) value. An alphabetic sort in descending order begins
with Z

Dimmed A menu command that cannot presently be selected—usually because it is

Command irrelevant to the current operation. Dimmed items are also referred to as
“grayed out” and can appear in dialog boxes as well as in menus.

Export To create afile in a program that can be read by another. To ensure
compatibility with the program that will receive the data, most programs that
export data can write it in a number of different file formats

Field Fields are the building blocks of which records are composed. Each database
field is meant to store one particular type of information, such as Date, or
Amount etc.

File Any named collection of information that is stored on disk. Programs,
documents, and system software components are examples of files.

File Format A standard specification for the way data is stored on disk and interpreted.

Find A command for locating a record or group of records based on criteria you
establish

Found set The remaining visible (or browsed) records following a find procedure, such as
a find request.

Menu A list of choices presented by a program from which you can select an action.
Menus appear when you click menu titles in the menu bar

Record The basic unit of every database. All databases are composed of records, each
storing information for a single entity, such as a person, catalog item, etc.

Search Information used as a reference in search or find operations

Criteria

Sort To rearrange database records in a different order than the one, which they
were originally entered.

Sort Order The order in which a field is sorted, e.g., ascending, descending.

pac
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APPENDIX B — DATABASE FIELD MAPPING GUIDE

Fields in "Clients" Module that accept user data

Field Name Type Description

Address1 Normal, Text |Client's address

Address2 Normal, Text |Client's additional address
Age Normal, Text |Client's age

AgeRange Normal, Text  |0-14 or 15+

Allergies Normal, Text [Client’s allergy information
BloodType Normal, Text [Client's blood type

BloodType_Hb_Hct

Normal, Text

Client's blood type

BloodType_IDC

Normal, Text

Client's blood type

BloodType_Rh

Normal, Text

Client's blood type

Children Normal, Text  [Number of client's biological children
CommentsNotes Normal, Text |[Comments and notes
DateOfBirth Normal, Date [Client's date of birth

DrugsDispensed

Normal, Text

ARV drugs client is receiving

DrugsRefillDate

Normal, Text

ARV drugs refill dates

Education Normal, Text  |Highest educational level attained by client
EmergencyContact Normal, Text  |Client's emergency contact

LabResult Normal, Text |Client's CD4+ count

LabsDue Normal, Text  |Date of next lab test (mm/dd/yyyy)
LabsLast Normal, Text |Date of last lab test (mm/dd/yyyy)

Married Normal, Text  |Client's marital status

MobileEmergencyContact

Normal, Text

Mobile telephone number of client's emergency
contact

MobilePatient

Normal, Text

Client's mobile telephone number

Nurse Normal, Text  |Name of attending nurse

NurseDue Normal, Text  [Date of next nurse visit (mm/dd/yyyy)
NurselL ast Normal, Text  [Date of last nurse visit (mm/dd/yyyy)
Parents Normal, Text |Names of client's parents

PatientFirstName

Normal, Text

Client's first name

PatientID

Normal,
Number

Client's ID number: must be numeric

PatientLastName

Normal, Text

Client's last name

Physician Normal, Text [Name of attending physician
PhysicianDue Normal, Text |Date of next physician visit (mm/dd/yyyy)
PhysicianLast Normal, Text  |Date of last physician visit (mm/dd/yyyy)
POBox Normal, Text  [Post Office Box of client
PregnancyStatus Normal, Text  [Number of weeks

Pregnant Normal, Text |Yes or No

Programs Normal, Text |Program area applicable to client
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Fields in "Clients" Module that accept user data

Field Name Type Description

ReceivingTreatment Normal, Text |ART or PMTCT

Relationship Normal, Text |Relationship of emergency contact
Religion Normal, Text |Clients religion (optional)

ServiceSite_Location

Normal, Text

Name of service site where client is receiving service

Sex

Normal, Text

Female or Male

Siblings

Normal, Text

Number of client's siblings

Start_ARV_Therapy

Normal, Text

Date client started ARV therapy

Start_PMTCT_Counseling

Normal, Text

Date client started PMTCT counseling

Start_TB_Therapy

Normal, Text

Date client started TB therapy

State

Normal, Text

State where client is resident (may be different from
that of Service site)
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Fields in "service_outlets_programs" that accept user data

Field Name Type Description
Address1 Normal, Address of Service site
Text
Address2 Normal, Additional address for Service site
Text
AmountAllocated1 Normal, Amount allocated to first selected service/program
Number | area
AmountAllocated2 Normal, Amount allocated to second selected
Number service/program area
AmountAllocated3 Normal, Amount allocated to third selected service/program
Number area
AmountTotalLocalCurrency | Normal, Total amount in local currency received by service
Number | site (only if funds were received in local currency)
AmountTotalUSD Normal, Total USG funds received by Service site
Number
CommentsNotes Normal, Comments and/or notes
Text
CompletionDate Normal, Date GIS survey was completed (This field is
Text available only on the GIS form)
ContactFirstName Normal, First name of primary contact person for Service
Text site
ContactLastName Normal, Last name of primary contact person for Service
Text site
Email1 Normal, Primary email address for contact person
Text
Email2 Normal, Other email address for contact person
Text
Email3 Normal, Other email address for contact person
Text
EndDate Normal, End date of Service site's report cycle
Date
EstimatedPop Normal, Estimated population of state where Service site is
Number located (This field is available only on the GIS form)
Faxi Normal, Primary fax number for Service site
Text
Fax2 Normal, Secondary fax number for Service site
Text
Geographical Coverage Normal, National, North Central, North East, North West,
Text South East, South West, South South
ImplementingAgency Normal, US Implementing Agency (This field is available
Text only on the GIS form)
Indicators Normal, Prevention, Prevention of Mother-to-child
Text transmission, Counseling and Testing, Care,
Support, and/or Treatment, OVC, Labs, Strategic
Information, Other (Capacity Building)
Latitude Normal, Service site Latitude in Degrees, Minutes, Seconds

Text

=
[}
=
v
>
V)
4~
=
()
=
L)
o
(0}
=
M
=
M
i
[}
(@)
——
=
o
o+
m
=
()
=
L
od
(=]
(=
; Ty
@]
=
=
o
=
<
L
o
Ll
o

age
2;?(, 28




Fields in "service_outlets_programs" that accept user data

Field Name Type Description
LatitudeDecDeg Normal, | Service site Latitude in Decimal Degrees
Text
LGA Normal, | Local Government Area where Service site is located
Text (This field is available only on the GIS form)
Longitude Normal, | Service site Longitude in Degrees, Minutes, Seconds
Text
LongitudeDecDeg Normal, | Service site Longitude in Decimal Degrees
Text
Mobile1 Normal, | Primary mobile telephone number for contact
Text person
Mobile2 Normal, | Secondary mobile telephone number for contact
Text person
OfficialPop Normal, | Official population of state where Service site is
Number | located (This field is available only on the GIS form)
POBox_PMB Normal, | Mail box for Service site
Text
Service_Site Normal, | Name of Service site
Text
Services_Programs Normal, | Abstinence and/or Be Faithful, Other Behavior
Text Change, Medical Transmission: Blood Safety,
Medical Transmission: Injection Safety, PMTCT, HIV,
Counseling and Testing, Treatment (ART), Palliative
Care (Facility/Community or Home-Based), TB/HIV,
OV(, Labs, Strategic Information, Policy
Development, Institutional Capacity Building,
Stigma & Discrimination Reduction, Community
Mobilization for Prevention, Care and/or Treatment
ServiceSite_Type Normal, | Clinic, Faith-Based, Hospital, Mass Media, Mobile
Text Unit, Other
StartDate Normal, | Start date of Service site's report cycle
Date
State Normal, | State where Service site is located
Text
TA_Received Normal, | YesorNo
Text
TA_Received_EndDate Normal, | Date Service site stopped receiving TA
Text
TA_Received_ProgramArea | Normal, | Strategic Information, Policy Development,
Text Institutional Capacity Building
TA_Received_StartDate Normal, | Date Service site began receiving TA
Text
Telephone1 Normal, | Primary telephone number for contact person
Text
Telephone2 Normal, | Secondary telephone number for contact person
Text
Title Normal, | Title of primary contact person
Text
Village_Community Normal, | Village/Community where Service site is located
Text (This field is available only on the GIS form)
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Fields in "service_outlets_programs" that accept user data

Field Name Type Description

Ward Normal, Ward where Service site is located (This field is
Text available only on the GIS form)

WaypointNumber Normal, GPS unique location identifier (This field is
Text available only on the GIS form)

YearOfCensus Normal, Year census was conducted (This field is
Text available only on the GIS form)

YearOfEstimate Normal, Year population estimate is based on (This field
Text is available only on the GIS form)
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Fields in "training" module that accept user data

Field Name Type Description
Address Normal, | Address of participant
Text
Duration Normal, | Duration of training
Text
Emaila Normal, | Primary email address for training participant
Text
Email2 Normal, | Other email address for training participant
Text
Email3 Normal, | Other email address for training participant
Text
EndDate Normal, | Date training completed
Date
Faxi Normal, | Primary fax number for training participant
Text
Fax2 Normal, | Secondary fax number for training participant
Text
Indicators Normal, | Prevention, Prevention of Mother-to-child transmission,
Text Counseling and Testing, Care, Support, and/or Treatment,
OV(, Labs, Strategic Information, Other (Capacity
Building)
Knowledge_Skills Normal, | Expected knowledge, skills and/or competencies derived
Text from training
Mobile1 Normal, | Primary mobile telephone number for training participant
Text
Mobile2 Normal, | Secondary mobile telephone number for training
Text participant
ParticipantFirstName | Normal, | Participant's first name
Text
ParticipantLastName | Normal, | Participant's last name
Text
Service_Site Normal, | Service site training participant is affiliated with
Text
StartDate Normal, | Date training began
Date
State Normal, | State where training was received
Text
Telephone1 Normal, | Primary telephone number for training participant
Text
Telephone2 Normal, | Secondary telephone number for training participant
Text
Title Normal, | Title or job description of participant
Text
Training Program Normal, | Abstinence and/or Be Faithful, Other Behavior Change,
Area Text Medical Transmission: Blood Safety, Medical Transmission:

Injection Safety, PMTCT, HIV, Counseling and Testing,
Treatment (ART), Palliative Care (Facility/Community or
Home-Based), TB/HIV, OV, Labs, Strategic Information,
Policy Development, Institutional Capacity Building,
Stigma & Discrimination Reduction, Community
Mobilization for Prevention, Care and/or Treatment

=
[}
=
v
>
V)
4~
=
()
=
L)
o
(0}
=
M
=
M
i
[}
(@)
——
=
o
o+
m
=
()
=
L
od
(=]
b=
; Ty
@]
=
=
o
=
<
L
o
Ll
o

bage
27 0f 28




Fields in "training" module that accept user data

Field Name Type Description

Training_Retraining Normal, Text New Training or Retraining

TrainingObjective Normal, Text Specific learning objectives of
training

TrainingTitle Normal, Text Title of training

APPENDIX C - STEPS TO CONFIGURE MYODBC

Open Database Connectivity (ODBC) is a widely accepted application-programming interface
(API) for database access that uses Structured Query Language (SQL) as its database access
language.

Before using MyODBC driver to connect to the MySQL databases stored on our servers you
must configure an ODBC Data Source Name. The DSN associates the various configuration
parameters required to communicate with the databases to a specific name. The PEPFAR M&E
System uses the DSN to communicate with MySQL databases, thereby eliminating the need to
specify individual parameters each time you establish a connection.

Configure a MyODBC DSN using the parameters below in order to access MySQL databases
stored on our servers

Parameter Value Comment

Data Source A unique name to identify the

Name connection

Description A brief description of the Data Source

Server http://www.aidatasolutions.com | The hostname of the MySQL server

User user The username used to connect to
MySQL

Password user The password for the user account on
server

Database Select from list of available databases

Port 3306 The TCP/IP port to use for connection

Connector/ODBC 3.51.12 - Configure Data Source Name

Connector/0DBC b
MHSE‘%

Lagin |C0nnectDptions ” Advanced |

Password

Data Source Mame |pepfar |

The password For the server user

Description | | combination.

Server | | Optional ez
Default [empty]

User | |

Pazsword I |

Database | w |

L Test J [Diagnostics >>l [ Ok ] [ Cancel ] [ Help
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